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Installation

1-1 KX Driver

1 Installation

A printer driver is an application that sends documents to a printer and manages 
communication between a printer and your computer. Install the printer driver from 
the supplied Product Library CD-ROM. Once installed, a variety of printer settings 
can be configured. 

Note:  In Windows XP, Windows Vista, and Windows 2000, you must be logged in 
with administrator rights to install the KX Driver. If you connect the Universal Serial 
Bus (USB) cable before CD installation, it is strongly recommended that you cancel 
the Found New Hardware Wizard and install the software through the CD menu. 
Browsing the CD and installing each driver separately is not recommended.

1 Turn off the power for the computer and printer. 1

2 Ensure that the printer is ready to print (remove packing materials, insert paper and 
any toner or ink cartridges), then connect the computer and printer using either USB, 
a parallel cable, or a network cable. For further details on connecting the printer to 
the computer, refer to the printer’s Operation Guide. 2

3 Once connected, power on both devices. 3

If the Windows Found New Hardware Wizard appears, click Cancel.

4 Insert the Product Library CD-ROM into the CD drive. 4

After the installation program starts the Main Menu appears. 

Note:  If the Product Library Software Installation Wizard fails to start after 
inserting the CD-ROM into the CD drive, explore the CD drive, and double-click 
Setup.exe.

5 Click View License Agreement to read the license agreement. 5

6 Click Accept to proceed. 6

7 To begin installation, click Install Software. 7

8 The Software Installation Wizard appears. Click Next. 8

The installation differs depending on your operating system and connection method. 
Select your operating system and connection method from the list below and 
proceed to the referenced page to continue the installation.

Express Installation
Windows XP and Vista on page 1-2

Custom Installation
Windows XP - USB on page 1-3
Windows XP - Parallel Port (LPT) on page 1-3
Windows XP - Network Connection on page 1-4
Windows Vista - USB or Parallel Port (LPT) on page 1-4
Windows Vista - Network Connection on page 1-5
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Note:  KPrint installs a client port monitor that enables Windows TCP/IP printing to 
any network card connected to Kyocera printing systems. KPrint supports LPR and 
IPP printing. For the KPrint Installation instructions, refer to your CD. KPrint is now 
a standalone installer.

Express Installation

Express mode applies to a Universal Serial Bus (USB) or a network connection only. 
The installer finds the printer if it is turned on and connected by USB or network 
cable. The Kyocera Scanner Driver (TWAIN) is installed automatically in Express 
Mode. For the simple, default installation, select Express Mode. 

Note:  During any point in the installation process, if the Windows Security warning 
dialog box appears, click Install this driver software anyway.

In the Custom Mode, you are able to choose which software packages to install and 
specify the port. To use the Custom method, see Custom Installation on page 1-3.

Note:  In Windows Vista, the Kyocera Scanner Driver and WIA driver are installed 
with the printer driver.

Windows XP and Vista

In Windows Vista, the installation dialog boxes have a slightly different appearance, 
but the steps are the same.

1 For the simple, default connection select Express Mode and then click Next. 1

The Discover Printing System page opens and looks for your printer. If Discovery 
does not find your printing system, ensure that it is properly connected by USB or 
network cable and that it is turned on, and then retry Discovery.

2 At the Discover Printing System page, select the printing system you would like to 
install and click Next. 2

Note:  If the Found New Hardware Wizard appears, click Cancel. If the Hardware 
Installation warning dialog box appears, click Continue Anyway.

3 In Printer Settings, you can assign a name to the printing system. This is the name 
that appears in Windows Printers and Faxes and in the printer lists in applications. 3

Note:  If your printer is connected locally, Printer Settings does not appear, skip to 
step 4.

You can also choose to share this printer with others or set this printer as the default 
printer. Make your selection from the following choices, and then click Next. 4

• Share your printers with others
• Set the printer system as the default

4 In the Confirm Settings page, click Install if the settings are correct. Click Back to 
correct the settings. 5
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5 The Installation Wizard page appears with this message: Installation Completed. 
Click Finish to exit the Printer Installation Wizard and return to the CD-ROM main 
menu. 6

The installation of the printer is now complete. If prompted, restart your system.

Custom Installation

When using the Custom method you can specify the printer port and choose which 
software packages to install. 

Note:  During any point in the installation process, if the Windows Security warning 
dialog box appears, click Install this driver software anyway.

Windows XP - USB

1 Ensure that your printer and computer are connected using the Universal Serial Bus 
(USB) cable. 1

2 In the Installation Method page, select Custom Mode > Driver. If you also want to 
install fonts, select Utilities. 2

3 In the Connection Type page, select Universal Serial Bus (USB), and then click 
Next. 3

4 The Printing System page appears in certain conditions, for example, when the 
installer cannot detect the USB connection. From the list, select the printing system 
to install. Click Next. 4

5 In the Custom Installation page, ensure that the KX Driver is selected as the 
product and then click Next. If you intend to use the scanner, also ensure that the 
scanner driver is selected. 5

6 In the Confirm Settings page, click Install if the settings are correct. Click Back to 
correct the settings. 6

Note:  If the Found New Hardware Wizard appears, click Cancel. If the Hardware 
Installation warning dialog box appears, click Continue Anyway.

The installation of the printer is now complete. If prompted, restart your system.

Windows XP - Parallel Port (LPT) 

1 In the Installation Method page, select Custom Mode > Driver. If you also want to 
install fonts, select Utilities. 1

2 In the Connection Type page select Parallel Port (LPT), then click Next. 2

3 The Printing System page appears. From the list, select the printing system to 
install, and then click Next. 3

4 In the Custom Installation page, ensure that the KX Driver is selected as the 
product and then click Next. 4
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5 In Printer Settings you can assign a name to the printing system. This is the name 
that appears in Windows Printers and Faxes and in the printer lists in applications. 
Here you can also choose to share this printer with others or set this printer as the 
default printer. Make your selections and then click Next. 5

6 In the Printer Port page, select a port, and then click Next. 6

7 In the Confirm Settings page, click Install if the settings are correct. Click Back to 
correct the settings. 7

8 The Installation Wizard page appears with this message: Installation Completed. 
Click Finish to exit the Printer Installation Wizard and return to the CD-ROM main 
menu. 8

The installation of the printer is now complete. If prompted, restart your system.

Windows XP - Network Connection

1 In the Installation Method page, select Custom Mode > Driver. If you also want to 
install fonts, select Utilities. 1

2 In the Connection Type page, select Network connection and then click Next. 2

3 In the Network Port Type page select a port type. Select Standard TCP/IP Port. If 
you select Standard TCP/IP port, the installer automatically creates a new port if 
needed. 3

4 In the Printing System page, select the model and then click Next. 4

5 In Custom Installation, select the software packages you want to install, and clear 
those not intended for installation. Click Next. 5

6 In Printer Settings, you can assign a name for the printing system. This name 
appears in Windows Printers and Faxes and in the printer lists in applications. You 
can also choose to share this printer with others or set this printer as the default 
printer. Make your selections and then click Next. 6

7 In the Standard TCP/IP Port dialog box, you can select Discover or Host name or 
IP address. 7

Discover searches the network for the printer. After it is found select the printer and 
then click Next. To use Host name or IP address type the IP address or host name 
and then click Next.

8 In the Confirm Settings page, click Install if the settings are correct. Click Back to 
correct the settings. 8

9 The Installation Wizard page appears with this message: Installation Completed. 
Click Finish to exit the Printer Installation Wizard and return to the CD-ROM main 
menu. 9

The installation of the printer is now complete. If prompted, restart your system. 10

Windows Vista - USB or Parallel Port (LPT)

1 Ensure that your printing system is connected using a Universal Serial Bus (USB) 
cable, or a parallel cable. 1
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2 In the Custom Installation page, ensure that the KX Driver is selected as the 
product. If you intend to use the scanner, also check that the scanner driver is 
selected. To install fonts or utilities, click the Utility tab, and select from the options 
there. When you are finished selecting items for installation, click Next. 2

3 The Discover Printing System page appears. 3

Select your printing system from the list, which should show a Type of USB for a USB 
cable, or LPT (local port) for a parallel cable. Click Next, then go to step 7.

If Discovery does not find your printing system, a message box appears. Ensure that 
your printer is properly connected by the correct cable and is powered on, and then 
close the message box and retry Discovery.

- OR -

To manually select your printing system and port, select Custom select, and then 
click Next.

4 In the Printer Port page, select the port connected to your printing system. 4

• For a USB connection, the Port Name should begin with USB, and the 
Description should read Virtual printer port for USB. 

• For a parallel connection, the Port Name should begin with LPT, and the 
Description should read Local Port. 

Click Next.

5 The Printing System page appears. From the list, select the printing system to 
install, and then click Next. For a USB connection, go to step 7. For a LPT 
connection, go to step 6. 5

6 In Printer Settings, you can assign a name to the printing system. This name 
appears in Windows Printers and Faxes and in printer lists in applications. Here 
you can also choose to share this printer with others, or set this printer as the default 
printer. Make your selections, and then click Next. 6

7 In the Confirm Settings page, click Install if the settings are correct. If settings are 
not correct, click Cancel and restart the installation. 7

The Installation Wizard page appears with this message: Installation Completed. 
Select Print a test page if you want to verify that the printing system is printing 
correctly. Click Finish to exit the Printer Installation Wizard and return to the CD-
ROM main menu.

The installation of the printer is now complete. If prompted, restart your system.

Windows Vista - Network Connection

1 Ensure that the printing system is powered on and connected to the network. In the 
Installation Method page, select Custom Installation. Click Next. 1

2 In the Custom Installation page, ensure that the KX Driver is selected as the 
product. To install fonts or utilities, click the Utility tab, and select from the options 
there. When you are finished selecting items for installation, click Next. 2

3 The Discover Printing System page appears. 3
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To find a printing system already turned on and connected to the network, click 
Discover, select the printing system, and go to step 8.

If Discovery does not find your printing system, a message box appears. Ensure that 
your printer is properly connected by the network cable and that it is powered on, and 
then close the message box and retry Discovery.

- OR -

To manually select your printing system and port, select Custom select. Click Next.

4 The Printer Port page appears. If the port you want to use appears in the Port name 
list, select it and click Next, then go to step 8. 4

To create a new port, click Add Port, and then click Next. The Add Port Wizard 
page appears.

5 Type the printer name or IP address, and then click Next. The wizard automatically 
attempts to detect the TCP/IP port. If it cannot detect the port, the Additional Port 
Information Required page appears. Click Back to correct the IP address, or, if you 
are sure the address is correct, select an Address Type. Click Finish. 5

6 After the port has been created, the Completing the Add Standard TCP/IP Printer 
Port Wizard page appears. Click Finish to close the Add Port Wizard page and 
return to the installation wizard. 6

7 The installation program Printing System page appears. From the list, select the 
Printing System to install, and click Next. 7

8 In Printer Settings, you can assign a name to the printing system. This is the name 
that appears in Windows Printers and Faxes and in the printer lists in applications. 
You can also choose to share this printer with others or set this printer as the default 
printer. Make your selections, and then click Next. 8

9 In the Confirm Settings page, click Install if the settings are correct. If settings are 
not correct, click Cancel and restart the installation. 9

10 The Installation Wizard page appears with this message: Installation Completed. 
Select Print a test page if you want to verify that the printing system is printing 
correctly. Click Finish to exit the Printer Installation Wizard and return to the CD-
ROM main menu. 10

The installation of the printer is now complete. If prompted, restart your system.

Installing Optional Components

You can expand the functions of your printer driver by installing optional components, 
in the form of a plug-in that complement the ways in which you use your printer. A 
plug-in is a small computer program that interacts with a larger program to provide 
additional functionality. Available components may include Common profiles and 
Plug-ins.

1 In the CD Main Menu, select Advanced Tools. 1

2 On the Advanced Tools page, select Optional Printer Components. 2

3 The Optional Components Wizard dialog box appears. Click Next to install 
optional components or Cancel to close the wizard. 3



Installation Windows Vista - Network Connection

1-7 KX Driver

4 The Select Printer page appears. From the list, select the machine you want to 
install and click Next. 4

5 The Select Components page appears. Select the components to install, and click 
Next. 5

6 In any Select pages that appear make your selections and click Next. 6

7 In the Confirm Settings page, click Install if the settings are correct. Click Back to 
correct the settings. 7

8 The Printer Components Installation Completed page appears. Click Finish. 8

When you have completed installing printers and optional components, if prompted, 
restart your system.

Product Library CD

Selections in the Product Library include Install Software, Remove Software, 
Advanced Tools, Documentation, Software Release Notes and Select 
Language. Remove software provides a tool to eliminate the KX driver from your 
computer. The software release notes provide information about the contents of the 
CD-ROM, and known driver and hardware issues.

Click Documentation to view a list of available manuals.

You can select your interface language from the language menu. The Product 
Library menus use the selected language.

Windows XP/2000 Add Printer Wizard

This section describes how to install a printer driver using the Add Printer Wizard in 
Windows XP or Windows 2000.

Note:  During any point in the installation process, if the Windows Security warning 
dialog box appears, click Install this driver software anyway.

1 Click Start in the Windows taskbar, and click Printers and Faxes to open the 
Printers and Faxes window. 1

2 Click Add printer in the window area on the left. 2

Note:  The Add Printer Wizard can also be launched by clicking Add printer in the 
File menu of the Printers and Faxes window.

3 The Add Printer Wizard appears. The wizard provides you with step-by-step driver 
installation instructions. Follow the instructions on each page and then click Next to 
proceed to the next page. 3

Note:  If the Found New Hardware Wizard page appears, click Cancel. If the 
Hardware Installation warning dialog box appears, click Continue Anyway.
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4 When the Completing the Add Printer Wizard page appears, installation of the 
printer driver is now complete. To close the Add Printer Wizard, click Finish. If 
prompted, restart your system. 4

Windows Vista Add Printer Wizard

This section describes how to install a printer driver using the Add Printer Wizard in 
Windows Vista.

Note:  During any point in the installation process, if the Windows Security warning 
dialog box appears, click Install this driver software anyway.

1 Click the Start icon in the Windows taskbar at the bottom of the screen. In the Start 
window click Control Panel. In the Control Panel window under the Hardware and 
Sound category, click Printer. 1

2 In the toolbar at the top of the Printers window, click Add a printer. 2

3 The Add Printer Wizard appears. The wizard provides you with step-by-step driver 
installation instructions. Click either Add a local printer or Add a network, wireless 
or Bluetooth printer. Follow the instructions on each page and then click Next to 
proceed to the next page. 3

4 The last page of the wizard appears with a message that you’ve successfully added 
the printer you selected. Installation of the printer driver is now complete. Click Print 
a test page if you want to produce sample print output from the newly installed 
printer. To close the Add Printer Wizard, click Finish. 4
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2 Printer Properties

This chapter contains the following sections:

• Accessing Printer Properties 
• Installing Optional Devices 
• Administrator Settings
• User Settings
• Page Description Language (PDL) 
• Compatibility Settings 
• About

Follow the steps below to set your preferred options as the default settings. These 
default settings can be changed temporarily when printing from Windows-based 
applications.

Accessing Printer Properties

1 Click Start in the Quick Launch toolbar and click Settings > Printers and Faxes. 
The Printers and Faxes window appears. 1

2 Right-click the printer icon in the Printers and Faxes window. 2

3 Click Properties in the list. The Properties dialog box appears. 3

4 Click the Device Settings tab. 4

Installing Optional Devices

In the Device Settings tab, for each optional device installed in your printing system, 
select the equivalent setting under the Device Options list.

For models connected to a network, the Auto Configure button can be used to 
detect all available devices. See Auto Configure for more information. You can also 
specify the memory setting, PDL (Page Description Language), settings for the user, 
and more.
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Auto Configure

Auto Configure detects the installed device options on the printing system if it is 
connected over a network. This button appears in the Device Settings > Properties 
tab. 

Auto Configure can detect printing system devices such as input devices, output 
devices, and hard disk size. Then it updates the Device options list in the Device 
Settings tab. Auto Configure keeps the printer driver’s Device Settings consistent 
with the actual printing system devices.

Note:  Not all installed devices are detected by using Auto Configure. Before 
selecting OK in the Device Settings tab, check the settings to make sure they are 
correct.

To use this feature, click Auto Configure. An in progress message appears, saying 
Communicating with the printer to obtain setting information. Please wait a moment.

The check box settings in the Device options list are changed and the Preview 
image is updated according to the device options installed. Memory information also 
changes based on the setting information returned.

Under the following conditions the Auto Configure tool cannot communicate with the 
printing system:

• The printing system is powered off or is in the middle of the startup process. In 
such cases, Auto Configure displays the following message after the time out: 
Please verify that the printer is powered on and ready to print.

• The Windows XP firewall prevents the communication. It opens a Windows 
Security Alert dialog box with this message: Do you want to keep blocking this 
program? (Keep Blocking, Unblock, Ask me Later).

The Microsoft Windows XP Firewall settings can be changed to allow communication 
between the printing system and your computer. The default setting for Windows XP 
Service Pack 2 is for the Windows Firewall to be set to On. 
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When the Windows Security Alert dialog box appears, click Unblock to allow 
communication between the printing system and your computer.

When you click Unblock, Auto Configure is added to the Windows Firewall > 
Exceptions > Programs and Services list. The Windows Firewall is accessed 
through the Control Panel. 5

Auto Configure currently supports only TCP/IP ports for Microsoft Windows 2000, XP 
and Vista operating systems. 

A TCP/IP port can be either an IP address or the printing system name (Host name).

Device Options

1 Under Device options in the Device Settings tab, select the check boxes for 
devices installed in your printing system. 6

2 In the Memory box, select the memory capacity of your printing system. This setting 
is required to optimize the downloading of printing system fonts. 7

If you don’t know the memory capacity of your printing system, you can use Auto 
Configure so the information can be automatically selected. If Auto Configure is not 
available, then printing system memory can be seen on the status page. To generate 
a status page, select this option from operation panel. See Auto Configure on 
page 2-2 for more information. 8

Administrator Settings

The following settings can be specified by selecting Administrator in the Device 
Settings tab.

• User Login
• Job Accounting
• Administrator Password

User Login

Use User Login to add users with a user name and password. Use this feature to 
limit printing privileges to specified users, for secure printing and job accounting. The 
number of pages/job printed by each user can be tracked by the printer. See your 
printing system’s Operation Manual for information about tracking usage at the 
printer. 

User login provides job restriction by user, in contrast to the Job accounting feature, 
which assigns privileges by division or department. A maximum of 1000 login user 
names and passwords can be registered at the printing system. One hundred user 
names and passwords can be stored in the printer driver.

Note:  Job accounting and User login cannot be used at the same time.
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Users added in the printer driver should also be manually registered at the printing 
system’s operation panel.

The settings selected here are applied to every print job sent from this computer. The 
available options are as follows:

• Use specific login user name 
Select this option and type a user name and password to use the same user 
login for every print job. If this option is selected, the user does not have to type 
the name and password for each print job.

• Prompt for login user name 
When a user prints a document, the driver prompts you for a user name and 
password. You can use a Login User Name that is not on the list, and it does not 
be added to the list. When sending a print job, type a Login User Name and 
password when prompted, then click OK to print. 

• Prompt for login user name and validate 
Whenever a user sends a job to print, the driver prompts for user name and 
password. For the job to print, the user name and password entered must be on 
the Login User Name List (see Add Login User Names on page 2-4). 
You can use the Login User Names entered in the Login User Name List of the 
driver. When sending a print job, type a Login User Name and password when 
prompted, then click OK to print. This option ensures that the job prints only 
when the selected Login User Name is saved in the driver.

• Verify the printing system’s login user for each user (PC)
When this option is selected, the driver asks for a Login User Name and 
password the first time the a job is sent to the printer. The Login User Name 
must be one that is not yet registered on the Login User Name List. 
The name entered is added to the list, and thereafter the printer driver does not 
prompt for a user name and password.

Add Login User Names

1 In the Administrator Settings dialog box, select User login. 9

2 Click Login User Name List. 10

3 Click Add. 11
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The name and password are case-sensitive. The name and password can each be 
up to 64 alphanumeric characters. The user name is automatically filled in with the 
Login User Name by default, but can be changed. The user name can be up to 20 
characters.

Import and Export the Login User Name List

This section explains how to import and export your Login User Name lists. You can 
save the list of Login User Names created in the previous section to your personal 
computer or network. After saved, the list can be imported into other printer drivers.

Import

1 In Administrator Settings, click Login User Name List, then click Import. 1

2 Use Look in to browse for the file to import, or type the file name, and click Open.2

3 You can then select the imported file from the list of Login User Names. 3

Export

1 In the Administrator Settings dialog box, click Login User Name List, then click 
Export. 1

2 In Login User Names select a file to export, and click Export.

3 Use Save in to browse to a location to save the file, type the file name, and click 
Save. 2

Job Accounting

With Job accounting, you can assign account IDs to print jobs, or work with IDs 
already created at the printing system. Job accounting features help you manage 
and control the number of copies in a printing system. After IDs are created, from the 
printing system operation panel you can view the number of copies attached to a 
specific ID or limit the number of copies for individual IDs. IDs for newer models must 
be 8 digits or less.

Copy management must be set to ON at the printing system to use this feature. A 
maximum of 1000 account IDs can be assigned at the printing system and stored in 
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the printer driver. For complete information about the job accounting features of the 
printing system, please see the Operation Guide for your particular model.

Note:  User login and job accounting cannot be used at the same time in the driver.

Job accounting includes the following options:

Use specific account ID: This option can be used to specify a single account ID to 
manage the print jobs of a specific user. When the user prints, your jobs are sent with 
the account ID. You can use Password protect administrator settings to protect 
access to the Administrator Settings dialog box, so that the user cannot see or 
change this setting.

Prompt for account ID: This option can be used to prompt the user for an account 
ID when printing. When sending a print job, type an account ID when prompted, then 
click OK to print. The account ID must be one that has been registered at the printing 
system, or the job does not print.

Prompt for account ID and validate: This option can be used to prompt the user 
to specify an account ID that is saved in the driver. When sending a print job, type an 
account ID when prompted, then click OK to print. The account ID is validated 
against the account ID list, so you must type an ID from the list, or you cannot print. 

Display account ID list: This option can be used to display the list of IDs entered in 
the account ID list of the driver when sending a print job. This gives the user a 
selection of account IDs to choose from. 

Account ID List: This option can be use to add, edit, or delete account IDs from the 
account ID list of the driver. You can also give the IDs text descriptions to help 
manage and track them. After an account ID list is created, the list can be exported 
as a group by saving it as a text file (.CSV). To import an account ID list, browse for 
an existing list and save it in your printer driver. 

Administrator Password

You can set a password for the Administrator Settings dialog box. After a password 
is typed in, the administrator settings dialog box cannot be opened until the password 
is typed in the Enter Password dialog box. This prevents unauthorized personnel 
from changing the administrator settings. 

Set the Password 

1 In the Administrator Settings dialog box, select the Password protect 
administrator settings check box to open the Password dialog box. 1

2 In the Password dialog box, enter the new password using between 4 and 16 
characters in the Password text box. Re-enter the password in Confirm password 
and click OK. 2

Change the Password

1 In the Device Settings tab, click Administrator. 1

2 The Enter Password dialog box appears. Type the password and click OK. 2

3 The Administrator Settings dialog box appears. Clear the Password protect 
administrator settings check box. A Password message appears. 3
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4 Click OK. 4

User Settings

The following user information can be configured by selecting User in the Device 
Settings tab.

• Identification
• Units
• Language Preference

Identification

In this dialog box, type user name and department information.

1 In the Device Settings tab, click User. 1

2 The User Settings dialog box appears. In the User name and Department text 
boxes, type up to 31 characters. 2

• Type the preferred name in User name text box. 
• Type the user's department or group name in the Department text box.

3 Click OK.

Units 

The unit of measurement is used for the following settings:

• Custom Page Sizes setting in the Page Sizes section in the Basic tab.
• Spacing setting in the Watermark Add and Edit dialog boxes.
• Poster settings in the Layout tab.

In the User Settings dialog box, select either inches or millimeters.

Language Preference 

The Language preference option specifies the user interface language of the Device 
Settings tab of Printer Properties and all tabs of Printing Preferences. Available 
languages vary depending on your locale and your computer settings.

Select the preferred language from the Language preferences list. To activate the 
new language, click OK in User Settings and then in the Properties dialog box. 
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Page Description Language (PDL)

You have the option to change the Page Description Language (PDL) by selecting 
PDL in the Device Settings tab. You can choose from PCL XL, PCL 5e, KPDL 
(Kyocera Page Description Language), or PDF (Portable Document Format). The 
default is PCL XL, which is suitable for most printing purposes. After you select a 
PDL, the selection appears in the lower corner of the Preview image. 

PDL Settings

1 In the Device Settings tab, click PDL. 1

2 The PDL Settings dialog box appears. Select the desired language from the Select 
PDL list. See the table below for options and descriptions. 2

Option Description
PCL XL The most recent version of HP PCL and PCL 6. This PDL 

includes PCL 5e features.
Enhanced over PCL 5e in these areas: 
• Reduced file size 
• Better print speed 
• Faster return to application 
• Lacks backward compatibility with earlier PCL 

versions
PCL 5e Specifies PCL 5e as the PDL. 

• Fully compatible with earlier PCL versions 
• Bidirectional communication support 
• Wide selection of fonts for use with Microsoft Windows 

applications 
• Allows more options for utilizing PRESCRIBE 

commands within applications 
• Quality when printing complex graphics may be lower

KPDL Specifies KPDL as the PDL. KPDL is used when printing 
from applications that support PostScript 2 or 3. 
• An optional KPDL upgrade kit may be required for 

some models. 
• Kyocera’s emulation of PostScript printing 
• Strong graphics reproduction 
• Print speeds may be slower than PCL 5e 
• Requires more printing system memory than PCL 5e 
• Enables native TrueType font downloading
• Supports most Graphics Settings options
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In GDI compatible mode, vector graphics are rasterized for printing as bitmap 
images. Use the GDI compatible mode option to improve the graphic output quality 
created by the application. Due to memory restrictions, this feature is not available 
in certain printing environments.

3 Settings is available when the PDL is set to KPDL or PDF. 3

KPDL  

PDF

PDF Lets you print or save documents from multiple sources to 
Adobe PDF format. The PDF format is independent of the 
operating system and application software used to create 
documents.
Output to PDF is a plug-in that lets you print or save 
documents from multiple sources to Adobe PDF format. 
For information about installing the Output to PDF plug-in, 
see Installing Optional Devices on page 2-1.
• Use as an alternative to existing commercial 

applications for creating PDF documents. 
• Documents saved as PDF retain their original 

appearance, and can be viewed and printed with the 
free Adobe Reader on Windows, Mac OS, and UNIX 
platforms. 

Note: With PDF selected as the Page description 
language, only a limited set of driver options are available.

Option Description

Option Description
Allow data passthrough Data passthrough reduces errors when printing complex 

jobs from applications that use PostScript formatting.

Options Description
Embed fonts Select to ensure document fonts appear accurately in the 

PDF file on screen. This option significantly increases the 
file size and ensures accurate reproduction. 

Compress data Select to enable Flat compression for the generated PDF 
document. It significantly reduces the file size. Additional 
compression options are available within Adobe Acrobat.

Security Select 40-bit or 128-bit encryption for the print job and set 
passwords for opening a document and/or access to 
changing the document restrictions within Adobe Acrobat. 
Save to file must be checked for security to create secure 
PDF documents. Click Settings for additional security 
settings. 

Save to file Select to save the document as a PDF file. Password 
settings are available in the Security Settings dialog box. 

Note: If Save to file is selected, the document is not printed when you click OK in the Print 
dialog box. 
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Compatibility Settings

This feature supports compatibility for media source values unique to the printer 
driver, such as those for cassettes or feeders, so your newly installed KX Driver 
maintains identical media source support with the driver it replaces, whether for this 
driver or one from another manufacturer. If media source macros exist for the older 
driver, then the alignment of media source values maintain support without the need 
to change the macros. 

Use the Driver Info utility, available on the Product Library CD, to compare the source 
values for all installed drivers.

If the values for a given media source differ between the old and new printer drivers, 
reassign the value in the new driver to match the value in the previous driver. 
Compatibility settings can be adjusted by selecting Compatibility in the Device 
Settings tab.

Security Settings Lets you select an encryption level and create passwords 
for the generated PDF file. To access the Security 
Settings dialog, follow these steps: 
1. Open Printer Properties/Device Settings
2. Click on the PDL button
3. For Select PDL, choose PDF then click on the Settings. 
4. Place a checkmark next to Security, then click on 
Settings.
The following security options are available:
• Encryption: Encryption provides password protection 

so that a document cannot be easily opened or altered 
by unauthorized users.

• 40-bit: Provides low level security for a document. 
Supported for earlier versions of Adobe Acrobat and 
Adobe Reader 3.0 - 4.x. 

• 128-bit: Provides high level security for Adobe Acrobat 
and Adobe Reader 5.0 or later. 

Note: Adobe Acrobat 3 and 4 cannot open 128 bit 
encrypted PDF documents. 
• Passwords: Select passwords for changing security 

settings and for opening a document. Passwords are 
supported up to 16 characters in length.   

• Requires a password to change security settings: 
Type an Owner password. Within Adobe Acrobat, this 
password is be required to change the document 
restrictions in the Files/Properties/Security section. 

• Requires a password to open document: Type a 
User password. The user password must be entered at 
the time the PDF document is opened. This password 
must be different from the owner password used to 
control document restrictions. 

Options Description
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1 In the Device Settings tab, click Compatibility. 1

2 The Compatibility Settings dialog box appears. From the Media source 
enumeration list, select the paper supply method. The current value is listed in the 
Enumerated value box.

3 Type a new Enumerated value for the media source and click OK. You can also 
restore all the parameters to the default by clicking Reset. 2

The other options in the Compatibility Settings dialog box are: 3

• Ignore application collation
Use this option to bypass the Collate setting in the application, and give priority 
to the printer driver setting.

• Combine source and media type lists 
This option changes the Basic tab of Printer Properties so that Media type and 
Source are combined into one box, labelled Source.

• Enable manual duplex on network port 
Use this option to print using Manual Duplex (see page 3-5).

About

The About dialog box gives you information about the version number of the driver, 
and any plug-ins that are installed.

Version

To view the current driver information, click Properties > Device Settings > About, 
or from any Printing Preferences tab, click About. Click Version to view the 
following driver information:

• File Name
• Version
• Description
• Date
• Manufacturer
• Comments
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Plug-in

To display installed plug-in modules, click Properties > Device Settings > About, 
or from any Printing Preferences tab, click About. Click Plug-in to view the 
following driver information:

• Module
• Description
• Version

Note:  Adding or deleting plug-in modules can only be accessed from Properties > 
Device Settings. 
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3 Printing Basics

This chapter describes the following printing tasks when printing from Microsoft 
Windows applications.

• Basic Printing Tasks 
• Printing on Paper of Non-Standard Sizes
• Manual Duplex Printing
• Collate

Basic Printing Tasks

The steps required to print a document created with an application are explained 
below. You can select the printing paper size and output destination.

Basic Printing

1 Insert the proper paper size (such as A4) into the printing system's paper cassette or 
MP tray. 1

2 From the application’s File menu, select Print. The Print dialog box appears. 2

Select the desired printing system from the list of available printing systems. 3

3 Specify the number of copies to print in the Number of copies box. You can print up 
to 999 copies. When printing two or more copies, enable the Collate check box for 
collation. Number of copies and Collate can also be specified in the Basic tab. See 
page 3-6 for further information. 4

If Ignore application collation is selected in the Compatibility Settings dialog box, 
the Print dialog Collate setting is not applied.

When using Microsoft Word, we recommend that you click Options, and for default 
tray select Use printer settings.

4 Click Properties to open the Properties dialog box. 5
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5 In the Basic tab, click Page Sizes to open the Page Sizes dialog box. In the Select 
page size list, select a page size for the print job. 6

6 Click OK to return to the Basic tab. 7

For best results when printing on transparencies or recycled paper (the back side of 
paper which has already been printed on), from the Media type list select the media 
type. For further details, see Media Types on page 3-3.

The printing system automatically selects the paper size that matches the size 
specified above. A message appears requesting you to load paper into the MP tray 
if the proper paper size is not available.

7 Click the Source list to specify the paper cassette for printing.

8 Choose either Portrait or Landscape to match the document page orientation. You 
can rotate the document 180 degrees by selecting the Rotated check box. 8

9 Click OK to return to the Print dialog box. 9

10 Click OK to start printing. 10

Print Sizes

This section describes how to print documents of different sizes than the original 
document. The document image is adjusted to match the size you select. If you 
would like to manually input the Scaling percentage, see Scaling on page 4-3.

1 In the print application, select File > Print. 1

2 In the Print dialog box, click Properties. 2

3 In the Page Sizes list, select the document’s paper size and click OK. 3



Printing Basics

3-3 KX Driver

4 In the Basic tab, click the Print Size list and select the preferred output paper size.4

5 Confirm the proper paper size is loaded. Click OK to return to the Print dialog box. 5

6 Click OK to start printing. 6

The source document is automatically scaled to fit the output paper size. 

Media Types

The printing system automatically selects the paper size specified in the Page Sizes 
setting in the Basic tab by default when you are printing on regular paper. However, 
the printing system supports a wide variety of printing media.

You can specify the media type in the Media type setting for media selection when 
using non-standard types of printing media, such as recycled paper, labels, or 
transparencies. You can also specify the finishing settings for best results.

Labels, transparencies, and envelopes must be printed using the MP tray. Ensure 
the paper is properly loaded by following the instructions outlined in the printing 
system's Operation Guide.

Note:  The default setting is for Source and Media type to be separate items in the 
dialog box, but it is possible to combine them using a setting in Compatibility 
Settings. If they are combined, the Media type list is not available. To change the 
Combine setting, open Printer Properties from the Microsoft Windows Printer and 
Faxes window, go to Device settings and then Compatibility Settings, and then 
clear the Combine source and media type lists selection.

When paper is properly loaded in the paper cassette, the printing system can 
automatically detect the paper size. The following steps specify the media settings:
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1 Load the paper in a paper cassette or the MP tray. 1

Note:  Use the MP tray in cassette mode (the default). For further details on media 
types and MP tray modes, refer to the printing system's Operation Guide.

2 In the print application, select File > Print. 2

3 In the Print dialog box, click Properties. 3

4 Select the document paper size from the Print Size list. 4

5 From the Media type list, select the type of media for printing, then click OK. 5

After printing begins, the printing system automatically selects the paper to match the 
paper size and specified media type.

Printing on Paper of Non-Standard Sizes

To use custom sizes of paper in your printing system, you must first define the 
custom paper sizes in the Properties dialog box.

Note:  For custom paper, supply the paper using the universal (adjustable) paper 
cassette or the MP tray.

Custom Paper Sizes 

1 Load the custom paper into the printing system. For further details, refer to the 
printing system's Operation Guide. 1

2 In the print application, select File > Print. 2

3 In the Print dialog box, click Properties. 3

4 Click Page Sizes. The Page Sizes dialog box appears. 4

5 Click New to display Custom_01 in the Name box. You can replace Custom_01 
with the name for your new custom paper size. The name can be up to 31 
characters. 5

6 Type the measurements in the Height and Width boxes in millimeters or inches. The 
unit (inches or millimeters) is selected in the User Settings dialog box, accessed 
from the Device Settings tab. For further details on changing the unit, refer to User 
Settings on page 2-7. For custom paper size dimensions, refer to the printing 
system’s Operation Guide. 6

7 Click OK to return to the Basic tab. 7

8 To add more custom paper sizes, repeat the steps above (Maximum 20 custom 
paper sizes). 
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Printing with Custom Paper Sizes

1 Select Print from the File menu. From the application’s Print dialog box, click 
Properties. 1

2 In the Basic tab, select the name of your saved paper size in the Print Size list. 2

3 From the Source list, select the source cassette for the custom page size. 3

4 Click OK to return to the Print dialog box. 4

5 Click OK to start printing. 5

Manual Duplex Printing

Manual duplex enables printing on both sides of a sheet for some models that do not 
have a duplex unit. Manual duplex orders the print job so that after the first half of the 
print job has been printed, the job can be flipped over and fed from the cassette for 
the second side printing. Manual duplex is not available when any of the options in 
the Publishing tab are used.

The steps for using Manual duplex may vary, depending on your printing system, 
what optional devices are installed, and what application you are printing from. 

The Print dialog boxes of some applications allow you to print just the odd or even 
pages so that you can use manual duplex. 

If the selected printing system does not have a duplex unit, a Manual duplex 
checkbox is available in the Microsoft Word Print dialog box. When this option is 
selected, the odd pages are printed first. The following message then appears on the 
screen: Please remove the printout of first side from tray and place it in the input bin. 
Then press OK to continue printing. This notifies the user to flip the printed pages 
over and re-insert them in the cassette or tray of the printing system, and proceed to 
print even pages.

Some Kyocera printing systems have a manual duplex setting in Printing 
Properties in the Basic tab. Instructions for using this method for manual duplex 
printing are below. If the Properties or Preferences dialog boxes for your printing 
system don't have manual duplex settings, look for an option to print just odd or even 
pages in the Print dialog box of the application you want to print from.

Manual Duplex Settings
• The printing system must be set to a local port. 
- OR - 
• When using a network port, select Enable manual duplex on network port in 

the Compatibility Settings dialog box, accessed from the Device Settings tab. 
See Compatibility Settings on page 2-10 for instructions on changing 
compatibility settings.

• The Source selection must be Cassette 1 or Cassette 2. 

Print on Both Sides

1 In the Basic tab, select Cassette 1 or Cassette 2 from the Source list. 1
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2 Select the Print on both sides (manual duplex) check box. 2

3 Select Flip on Long Edge or Flip on Short Edge. 3

4 Select Print manual duplex instructions to print an instruction sheet. Follow the 
printed instructions for placing the pages back into the cassette after the first side is 
printed. 4

- OR -

Clear Print manual duplex instructions and follow steps 5-7.

5 Click OK in the Properties dialog box and Print dialog box. 5

The even-numbered pages will be printed.

6 When printing stops, remove all printed sheets from the output tray. 6

With Flip on Long Edge selected, turn the stack over on the long edge and put the 
pages into the cassette. 

With Flip on Short Edge selected, turn the stack over on the short edge and put the 
pages into the cassette. 

7 Click OK in the Manual Duplex Instruction dialog box. 7

The odd-numbered pages will be printed.

Collate

Collate enables the driver to internally assemble print job pages in numerical 
sequence. It increases print speed to specify the printed page order of a multi-copy 
job. 8

• With Collate selected, the driver prints the job, set by set. All the pages of the 
first set are printed, followed by all pages of the next set. For example: For 
printing two sets of a three page document, the default page ordering would be 
1, 2, 3, 1, 2, 3. 

• With Collate cleared, the first page is printed for all sets, followed by the next 
page for all sets. For example: For printing two sets of a three page document, 
the default page ordering would be 1, 1, 2, 2, 3, 3. 

The driver graphics image displays the grouping of collating and non-collating. 

The printer driver automatically overrides the application's collate setting and uses 
the printer driver setting. To use the Basic > Collate option, clear the Device 
Settings > Compatibility > Ignore application collation check box. 9
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4 Layout

In the Layout tab you can arrange document data on printed pages without changing 
the original document.

• Multiple pages per sheet prints more than one document page on a single 
sheet. 

• Poster prints a large banner using several sheets of paper. 
• Scaling increases or decreases the print size.
 

Multiple Pages Per Sheet

You can print multiple pages of a document on a single sheet of paper. Pages can 
be arranged in a variety of ways, and a border can be printed around each document 
page.

1 In the print application, select File > Print. 1

2 In the Print dialog box, click Properties. 2

3 Click the Layout tab. 3

4 Select Multiple pages per sheet. 4

5 In the Pages per sheet list, select the number of source pages to be printed per 
sheet. 5

6 From the Layout list, select the horizontal and vertical direction for the page layout.6

Examples: 
• If you select six pages per sheet and select Top to bottom and left, the pages 

are arranged from the top right corner to the bottom left corner. 
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• If Auto is selected, the pages are arranged from the top left corner to the bottom 
right corner.

7 Select the Print borders check box to print a border around each document page.7

Poster

You can print a document in a larger size than the paper supported for the printing 
system. The Poster feature allows you to increase the print size, print portions of the 
document on several sheets of paper, then assemble the sheets into a large banner, 
up to 25 times larger than the original document.

Sheets Per Page

In the Sheets per page list, select the size of the desired poster, in relation to the 
original document size. The list shows the number of sheets to be printed and the 
maximum poster size. The final size may be reduced slightly depending on 
selections made in the Poster Settings dialog box. For further details, refer to Poster 
Settings on page 4-2.

Available Poster Sizes

• Select 2 x 2 to print a poster 4 times larger than the original.
• Select 3 x 3 to print a poster 9 times larger than the original.
• Select 4 x 4 to print a poster 16 times larger than the original.
• Select 5 x 5 to print a poster 25 times larger than the original.

The dimensions shown after each option are based on the selected Page size in the 
Basic tab. For further details on selecting a page size, refer to Basic Printing Tasks 
on page 3-1. 

The unit (inches or millimeters) is selected in the User Settings dialog box, 
accessed from the Device Settings tab. For further details on changing the unit, 
refer to User Settings on page 2-7.

Print Format

If you are new to poster printing, you may want to print a proof sheet, in addition to 
the poster, to guide you in assembling the printed poster sheets. The proof sheet 
shows all poster pages on one sheet with markings that show how to assemble the 
sheets. Under Print format:
• Select Poster pages to print only the sheets of the poster.
• Select Proof sheet to print only a one-page proof sheet.
• Select Poster pages and proof sheet to print all poster sheets and a one-page 

proof sheet.

Poster Settings

To make it easier to create a poster, you can print visual cues on the poster sheets 
that provide help in cropping and assembling the pages. In the Layout tab, click the 
Poster Settings button to open the Poster Settings dialog box.

You can use any combination of the following options in the Poster Settings dialog 
box.
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• Overlap edges 
Select this option to duplicate the edges of document data on adjoining sheets. 
Poster appearance is improved when the edges overlap slightly. Select the 
check box, then type or select a value between 0.00 and 1.20 inches (0.0 and 
30.4 mm). This option reduces the final poster size slightly.

• Print crop marks 
Select this option to print a border at the edges of each poster sheet. You can 
crop each sheet on the border before assembling the sheets. This option 
ensures that data on adjoining sheets matches precisely.

• Print assembly marks 
Select this option to print numbers at the edges of each sheet, matching 
numbers on adjoining sheets. Assemble each sheet edge to the same numbered 
edge on another sheet. For a large poster with many sheets, this option ensures 
that the poster assembles correctly.

Scaling 

Based on the page size and print size specified in the Basic tab, you can reduce or 
enlarge the image from 20% to 500% of the original size.

Click the Layout tab in the Properties dialog box, and type the scale percentage into 
the Scaling (20-500%) box, or click the up or down arrow buttons to adjust the value.

Gutter

Based on the page size and print size specified in the Basic tab, you can increase 
the top and/or left margin. 

Click Gutter to increase the outside margins in a range from 5.0 to 25.4 mm (0.20 to 
1.00 inch). The left and/or top margins can be adjusted.

• To increase outside margins on the left side of the page, enter a number into the 
Left (long edge) box. This option may not be available, depending on your 
Orientation and Print on both sides settings in the Basic tab.

• To increase outside margins at the top of the page, enter a number into the Top 
(long edge) box. This option may not be available, depending on your 
Orientation and Print on both sides settings in the Basic tab.

• Since the Gutter feature shifts document data to the right or down, select the 
Reduce image to fit check box if the printed data extends beyond the edge of 
the paper when changing the gutter setting. The size of the printed data is 
decreased slightly to fit in the printable margins of the page. 

• If the document data is small enough that it does not extend beyond the edge of 
the paper when the gutter is increased, clear the Reduce image to fit check 
box.

If you want to change the page size, refer to Print Sizes on page 3-2.
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5 Imaging

The Imaging tab contains Quality and Grayscale options for print jobs.

Print Quality 

1 In the print application, select File > Print. 1

2 In the Print dialog box, click Properties. 2

3 In the Properties dialog box, click Imaging. 3

4 Select a Print quality from the list. 4

5 If you select Custom as the Print quality, next to the list click Custom Quality to 
open the Custom Quality Settings dialog box. 5

Print Quality
Option Description
High quality Uses the highest printing system resolution.
Proof Uses the second highest printing system resolution.
Draft Uses a resolution of 600 dpi.
Custom Choose your own combination of settings for 

Resolution, Kyocera image refinement, and 
EcoPrint.
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Custom Print Quality Settings 

You can select one or more Custom Quality Settings:

• Resolution 
• Kyocera image refinement
• EcoPrint

These settings can extend the life of toner cartridges by adjusting print resolution to 
reduce the amount of toner used.

Fonts 

The Fonts feature lets you specify how TrueType fonts are sent to the printing 
system. The chosen method affects the speed and quality of the print job. 

Note:  All of Kyocera's device fonts are TrueType fonts; do not disable them in the 
driver.

1 Click Fonts to open the Font Settings dialog box. 1

Custom
Option Description
Resolution The number of dots printed in one inch. At higher 

resolutions more detail appears in the print job. Select 
Fast 1200 mode, 600 dpi, or 300 dpi. 

Kyocera image 
refinement

Smoothes the outlines of text and vector graphics. 

EcoPrint Makes text and graphics appear lighter in the printed 
job.
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2 Select one of the methods for sending TrueType fonts, and then click OK to save 
your selection: 2

Note:  GDI compatible mode does not support Substitute with device fonts. For 
further details on GDI compatible mode see page 2-9.

Fonts

Option Description
Download as outlines Best suited for large documents or print jobs using 

multiple fonts and font sizes. Print speeds are faster 
because of the optimization features in this setting. 
The repetition of similar font data sent to the printing 
system is reduced, thereby increasing the print speed. 
Print speed is not increased when using Asian fonts 
such as Japanese, Chinese, and Korean, because of 
the large amount of font information used for these 
particular fonts. 

Allow native download Improves text quality and increases print speed by 
converting TrueType fonts to Adobe Type 42 font 
format. This feature is available when KPDL is 
selected in the PDL Settings dialog. For further details 
on changing the page description language, refer to 
PDL Settings on page 2-8.

Download as bitmaps Bitmap downloading provides more detail, however it 
creates large file sizes. For print jobs with very small 
fonts (point size 1-4), user-defined fonts, or Asian 
fonts.

Substitute with device 
fonts 

System fonts and device fonts are automatically 
matched based on typeface name. To match a specific 
device font with a system font, select Substitute with 
device fonts, then click Fonts to open the Font 
Substitution dialog box.
Select under these circumstances:
• To increase print speed and efficiency.
• To change a font found throughout a large 

document. This selection replaces the old font with 
the desired font.
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Font Substitution

With Substitute with device fonts selected as the font setting, click Fonts to open 
the Font Substitution dialog box. 

The System fonts list shows the fonts installed on your computer. The printing 
system fonts are listed in the Available device fonts list. Select the system font, and 
then the available device font to be substituted. If the device font does not have 
similar font characteristics to the system font, character spacing in the document 
appears incorrect.

Disable Device Fonts

In some cases, the printing system substitutes fonts even if you send the TrueType 
fonts as outline fonts or bitmap images. Select Disable device fonts to prevent 
substitution of device fonts for TrueType fonts.

When printing with Autodesk or Adobe applications, select Disable device fonts to 
overcome device font limitations with these applications. Device fonts are normally 
visible in application font lists as printer icons next to the font name, unless there are 
equivalent system fonts, in which case the “TT” TrueType icon remains.

This option also improves portability of printable data. (If cleared, device fonts may 
not match when sent to a different printing system.)

The Substitute with device fonts option is disabled if Disable device fonts is 
selected.

Graphics 

From the Imaging tab, click Graphics to open the Graphics Settings dialog box. 
Choose your graphics settings, and then click OK to save your selections. See below 
for descriptions of graphics settings options.

Note:  Some options are available only when a specific PDL is selected. For further 
details on changing the page description language, refer to PDL Settings on 
page 2-8. 
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Pattern Scaling

Adjust the pattern scaling to improve visual compatibility between screen and print 
output. 

If printed patterns and fills do not match the appearance of that on the screen, use 
this feature to select a different print density.

Inversion Options

Inversion options are available when KPDL is selected in the PDL Settings dialog 
box.

Optimization

Optimization selections are available when KPDL is selected in the PDL Settings 
dialog box. 

Pattern Scaling
Option Description
Auto (default setting) In most cases, this option prints patterns and fills to 

match the on-screen appearance.
Coarse Prints patterns and fills with the fewest number of lines, 

patterns, or dots. Coarse is the same as Auto when 
PCL 5e is selected in the PDL Settings dialog box.

Medium Prints patterns and fills with a greater number of lines, 
patterns or dots than the Coarse setting. Medium is the 
same as Auto when KPDL is selected in the PDL 
Settings dialog box. 

Fine Prints patterns and fills with the greatest number of 
lines, patterns, or dots. Printed patterns and fills may 
appear more dense than the on-screen appearance. 

Option Description
Reverse image Prints images like a photo negative, reversing black 

and white areas of the image. 
Mirror print Prints the page content backwards, as it would appear 

in a mirror image.

Optimization
Option Description
Fast printing Delivers images in binary format. Fast printing 

decreases spool size and increases print speed. Use it 
for most everyday printing needs. 

Document portability Creates a PostScript file in ASCII text encoding. Unlike 
the binary format created in Fast printing, the ASCII 
text created with this selection can be edited.
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Halftone Screen

An experienced user can adjust Halftone Screen settings to create shades of gray in 
graphic images. The Halftone Screen process breaks down the image into dots. 
Larger dots spaced close together create darker shades, and smaller dots spaced 
farther apart create lighter shades. Shading can be varied by adjusting the number 
of rows of dots, the angle at which rows of dots are placed, and the shape of the dots. 

Halftone Screen is available only when KPDL is selected in the Device Settings tab, 
in PDL Settings. If GDI compatible mode is selected in the PDL Settings dialog 
box, Halftone Screen is unavailable.

1 From the Graphic Settings dialog box, click Halftone Screen. 1

2 Clear the Use printer’s default screens check box. 2

3 Select from the list for each option, or enter the values: 3

Halftone Screen
Option Description
Ink Black is the only available ink color.
Frequency Number of rows of dots per inch or centimeter. Enter a 

numeric value in the Frequency box, and select lines/
inch or lines/cm.

Angle Select the angle at which rows are aligned. An angle is 
measured in degrees, ranging from -180 to +180.
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Grayscale 

Use the Grayscale options to adjust the appearance of graphics and text produced.

Grayscale adjustment settings let you change the Brightness and Contrast of 
graphics for monochrome printers. Grayscale adjustment settings are useful if 
graphic images are printing too light, too gray, or too dark. Text remains unaffected.

1 Click Adjustment to open the Adjustment Settings dialog box. 1

A preview image in the dialog box illustrates any brightness and contrast changes.

2 Drag the Brightness slider right to lighten, or left to darken the graphic images of the 
print job. 2

You can also change brightness by entering a numeric value in the text box at the 
right. The brightest setting is +100; the darkest is -100. Zero is the default mid-level 
setting. Adjusting brightness is useful when graphic images are printing too dark or 
too light. Text remains unaffected. 

Shape Select the shape of the halftone dot. The choice for the 
best halftone shape depends on the pattern and 
number of colors for your image. 
Ellipse  Resists optical jump, which is when areas of 
an image that should be smooth suddenly become 
darker. An ellipse shape provides a smoother 
gradation of tones. Choose for images with dark 
areas. 
Round  Resists moiré formation and dot gain. Moiré 
formation is an unintended pattern that occurs when 
two or more colors are printed at the wrong angles. 
The correct angles depend on the number of colors 
being printed. Dot gain is when the halftone dots 
increase when printed, causing a moiré pattern. 
Choose for images with light tints and highlighted 
areas.
Line  Used for special effect. You can change the 
effect by selecting a different Angle.

Increase accuracy of 
screens

Uses a very precise halftone screen which provides 
better print quality, but may increase printing time.

Halftone Screen
Option Description

Grayscale
Option Description
Print text as black Prints all color text as black. This is useful for 

increasing the detail for light colored text printed by 
monochrome printers. White text and image colors are 
unaffected.

Print graphics as black Prints all colors as black. This feature works for vector 
graphics only, and is most useful for CAD applications. 
Readability is improved for CAD blueprints because 
different colored objects print more clearly.
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3 Drag the Contrast slider right or left to increase or decrease proportion of light to 
dark in the graphic images of the print job. 3

A high contrast setting decreases the grayscale spectrum, making light grays lighter 
and dark grays darker. A low contrast setting increases the grayscale spectrum, 
making light grays darker and dark grays lighter. 

You can also change contrast by entering a numeric value in the text box at the right. 
The highest contrast setting is +100; the lowest is -100. Zero is the default mid-level 
setting. Adjusting contrast is useful if graphic images are printing too gray, or too 
black and white. Text remains unaffected.
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6 Publishing

This section describes the Cover mode, Page insert, and Transparency interleaving 
features of the printer driver. When these options are used with the MP tray, cassette 
mode (the default setting) must be set. For further details, refer to the printing 
system's Operation Guide.

• Cover mode: Adds a front or back cover to your document. 
• Page insert: Inserts blank or printed pages before pages in your document. 
• Transparency interleaving: Inserts a blank or printed page between 

transparencies.

Printing with Covers

For your document's front cover or front and back covers, you can insert and print on 
paper that is a different weight or color than the paper for the body of the document. 
You can also specify cover printing when completing booklet printing settings. The 
paper used for printing the document body is specified in the Paper settings in the 
Basic tab of the Properties dialog box. The source of the cover paper is specified 
by adjusting the Media for cover settings in the Publishing dialog box. (When 
printing covers or inserting pages, manual duplexing is not possible and is 
unavailable in the Basic tab.) 

Although Cover mode and Page insert may be used simultaneously, they cannot 
be used with Transparency interleaving (described in Transparency Interleaving on 
page 6-5).

1 In the print application, select File > Print. 1

2 In the Print dialog box, click Properties. 2

3 In the Properties dialog box, click the Publishing tab. 3
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4 Select the Cover mode check box. Select from the page arrangements described in 
the table below. 4

Cover Printing Options

Check Box Selection Cover Insertion Type
Front  Inserts a blank front cover.

Front
Front Outside

 Prints on the outside surface of the front cover.

Front and Back  Inserts blank front and back covers.

Front and Back
Front Outside

 Prints on the outside surface of the front cover and inserts 
a blank back cover.

Front and Back
Front Outside
Back Inside

 Prints on the outside surface of the front cover and inserts 
a blank back cover.

Front 
cover

Front 
cover

Front 
cover

Back
cover

Front 
cover

Back
cover

Front 
cover

Back 
cover
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Edit Cover Printing Options

1 From the Media for cover list, select the media type or source cassette for the front 
and back covers. When you choose the media type, a source cassette matching that 
media is automatically selected. Heavy, thin, or other special papers must be 
supplied from the MP tray. 1

2 Load the paper for the front and back cover in the paper cassette selected in step 1. 2

3 Click OK to return to the Print dialog box 3

4 Click OK to start printing. 4

Page Insert

You can insert a preprinted page or a page of a different paper type before a 
designated page. You can also print on the inserted paper. Using the standard duplex 
unit, you can also print on the reverse of the inserted paper. 

Although the Page insert and Cover mode may be used simultaneously, they 
cannot be combined with Transparency interleaving (described in Transparency 
Interleaving on page 6-5).

Insert Page Printing

1 In the print application, select File > Print. 1

2 In the Print dialog box, click Properties. 2

3 In the Properties dialog box, click the Publishing tab. 3

4 Select the Page insert check box. Select the option corresponding to your desired 
page arrangement as shown in the following table. (When inserting pages, manual 

Front and Back
Back Inside

 Prints on the inside surface of the back cover and 
inserts a blank front cover.

Check Box Selection Cover Insertion Type

Front 
cover

Back 
cover
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duplexing is not possible and is unavailable in the Basic tab.) To print on the front of 
the inserted page, enable the Print onto front check box. 4

Combinations

Adjust Media Combination Settings

1 Enter the page number where the inserted paper is to be placed. An insert paper is 
placed between the page number you entered and the page before it. For duplex 
printing without printing on the cover, you can designate for pages to be inserted 
starting with page 2 and ending on page 511. For duplex printing, and if you check 
print cover front and back, then the range is 3 to 511. If simplex printing, the range is 
from 2 to 511.

2 To designate several pages in the document for insertion, enter a comma (,) to 
separate them. For a series of insertions in a range of pages, use a hyphen (-). For 
example, to insert a page before pages 5, 11, 12, 13, and 18, enter [5,11-13,18]. 5

3 From the Media for page list, select the media type of the inserted page or the 
source paper cassette. 6

When you choose the media type, a source cassette that matches that media is 
automatically selected. Heavy, thin, or other special papers must be supplied from 
the MP tray. 7

4 Load the paper into the paper cassette. 8

5 Click OK to return to the Print dialog box. 9

6 Click OK to begin printing. 10

Check Box Options Page Insertion Types
Page insert Inserts a blank page before the second page.

Page insert
Print onto Front

Prints on the front surface of the inserted page.

Inserted 
page

Inserted 
page
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Transparency Interleaving

Transparency interleaving inserts a page between each transparency in a print job 
to prevent damaging the transparencies. This function is only available when printing 
on transparencies supplied from the MP tray. On these inserted pages you can print 
the same content as for the transparencies.

Transparency interleaving cannot be used together with Cover mode or Page insert.

Transparency Interleaving Method

1 In the print application, select File > Print. 1

2 In the Print dialog box, click Properties. 2

3 In the Basic tab, if the Source and Media type lists have been combined in the 
Compatibility Settings dialog box, select Auto (Transparency). 3

If the Source and Media type lists have not been combined, from the Media type list, 
select Transparency. 4

4 Click the Publishing tab. 5

5 Select the Transparency interleaving check box. To print the transparency content 
on the inserted pages as well, select the Print onto backing check box. 6

6 From the Media for backing list, select the media type of the backing sheet or the 
source paper cassette. When you choose the media type, the source cassette where 
that media is loaded is automatically selected. 7

7 Load transparencies into the MP tray and if necessary, load backing paper into the 
selected cassette. 8

8 Click OK to return to the Print dialog box. 9

9 Click OK to begin printing. 10
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7 Advanced

The Advanced tab contains special features that extend the capabilities of the 
printing system. Click the button at the left of the feature name to open a dialog box 
containing options for that feature.

• Prologue/Epilogue inserts PRESCRIBE printing system language commands 
into specified pages or locations of a print job.

• Watermark adds semitransparent text to a print job.
• Security Watermark adds watermark text and a background pattern to a print 

job. The text is nearly invisible when printed, but appears if the printed document 
is photocopied.

• Enable Client Profile lets you save custom profiles in your client driver or use the 
profiles on the server to apply with your print jobs.

• EMF Spooling lets you return to your application while running a large print job.

Prologue/Epilogue

Prologue/Epilogue lets an experienced PRESCRIBE user insert one or more printing 
system language command files into specific locations of a print job. For example, a 
command file may contain a macro (series of commands called to accomplish a 
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specific task), settings for printing system emulation, an electronic form, or a graphic 
object such as a logo or signature.

You can add or delete command file names in the list, or select a file to edit.

• To insert a command file into the print job and enable the features in the 
Prologue/Epilogue dialog box, select a file name from the list.

• To disable Prologue/Epilogue features and clear selection of all command files, 
select [None] at the top of the file list. (To disable a particular command file, 
select the file, then select Unassigned.)

Select Prologue/Epilogue File to Insert 

From the list, select the name of a command file to insert into the print job. (If no file 
names are visible in the list, you must click Add to browse for files on your computer 
or network to add to the list.) Selecting a file enables the insertion point options for 
that file in the dialog box.

Add

Click Add to browse your computer or network for command files. The files are plain 
text format and typically have a file name extension of either .txt or .log.

Edit

Select a file name in the list, then click Edit. Microsoft Notepad opens for editing the 
file text. To return to the Prologue/Epilogue dialog box, save any changes to the file 
and exit Notepad. 

Note:  Editing a file changes the original file in the computer or network directory.

Delete

Select a Prologue/Epilogue file name, then click Delete. In the message box, click 
Yes to confirm the deletion. To refuse the deletion, click No.

Note:  The file name only is removed from the Prologue/Epilogue list. The original 
file itself is not deleted; it remains in the computer or network directory.
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Insertion Point 

Each file in the list can be assigned only one insertion point. Choose one of the 
following insertion point options:

Unassigned

The selected command file is not inserted into the print job. This is useful if the list 
contains several command files, and you want to print some but not others. Select 
Unassigned for the files you do not want to print. 

Note:  To disable all command files (thereby disabling the entire Prologue/Epilogue 
feature), select [None] at the top of the file list.

Beginning of the print job

The command file is inserted as the first page of the print job. The document starts 
printing on the second page. 

End of the print job

The command file is inserted as the last page of the print job, which prints after the 
last page of the document. 

Note:  The following Start of the page and End of the page insertion point options 
are available only when PCL 5e is selected as the PDL (Page Description 
Language). For further details on changing the page description language, refer to 
PDL Settings on page 2-8.

Start of the page

The command file is inserted at the top of each page of the print job.

End of the page

The command file is inserted at the bottom of each page of the print job.

With Start of the page or End of the page selected, choose one of the following 
page options:

Only on odd pages

The command file is inserted into all odd-numbered pages.

Only on even pages

The command file is inserted into all even-numbered pages.

Pages

To insert the command file into specific pages, type individual page numbers 
separated by commas in the text box, or a page range separated by a hyphen.

For example, if you type 2 in the text box, the command file is inserted only into page 
2. If you type 1, 3, 5-12 the command file is inserted into page 1, page 3, and pages 
5 through 12. 
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If the Pages option is selected and you click OK without entering any numbers, you 
are prompted to specify page numbers. 

Watermark

Use the Watermark feature to create, arrange, and print semitransparent text in the 
background of a document. You can choose one of the standard watermarks or 
create your own text. The preview area at the left of the dialog box shows how the 
watermark appears on a page. This is useful for viewing any adjustments you make 
to the appearance and location of the text.

Select Watermark 

Select a watermark from the Select watermark list. The selection list contains these 
standard watermarks: Confidential 1, Confidential 2, Sample and Copy. For details 
on creating your own watermarks, see Add Watermark on page 7-5.

Page selection 

Page selection options are enabled after a watermark is selected from the list. 
Choose one of the following: 

All pages

The watermark prints on every page of the document.

First page only

The watermark prints only on the first page of the document.

All pages except first page

The watermark prints on all pages of the document except the first page.

Only on specified pages

To print the watermark only on specific pages, type individual page numbers 
separated by commas in the text box, or a page range separated by a hyphen.

For example, if you type 2 in the text box, the watermark prints only on page 2. If you 
type 1, 3, 5-12 the watermark prints on page 1, page 3, and pages 5 through 12. 
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If the Only on specified pages option is selected and you click OK without entering 
any numbers, you are prompted to specify page numbers. 

Print onto front outside cover

Select Print onto front outside cover to print the watermark on a separate front 
cover page before the document prints. This option is enabled when Cover mode is 
selected in the Publishing tab. 

If Cover mode and Front outside are selected in the Publishing tab, the Print onto 
front outside cover option in the Watermark dialog box shows as selected, but is 
disabled. This is because cover printing is already enabled by the two Publishing 
tab selections.

In the Publishing tab you can also select different media for the cover than that used 
for the rest of the print job. For further details, see Printing with Covers on page 6-1.

Add Watermark 

You can create your own custom watermarks with different fonts, styles, colors, 
sizes, positions, and angles. You can also set Count to have the watermark appear 
multiple times on the page.

1 Click Add to open the Add Watermark dialog box. 1

2 Type a descriptive name for your watermark in the Watermark name text box. The 
name can be different from the actual watermark text. After the new watermark is 
added, the name appears in the Select watermark list. 2

3 Type the text you want to print as a watermark in the Watermark text box. Your text 
appears in the preview area at the left of the dialog box. 3

4 To add the new custom watermark, click OK. To exit the dialog box without saving 
the watermark, click Cancel. 4

Additional Text Options

Fonts 

Select a font for the new watermark from the Font list, and select a font style, color, 
and size. 

In the Count box, type in the number of watermarks to appear on a page, from 1 to 
20. Selecting a number greater than 1 in Count enables the Spacing option. Type 
In a number for the distance between multiple watermarks, in tenths of an inch or 
millimeters. The unit (inches or millimeters) is selected in the User Settings dialog 
box, accessed from the Device Settings tab. For further details on changing the unit, 
refer to User Settings on page 2-7.
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Use the preview area and the Position or Angle features to adjust where the 
watermark prints on the page. 

Position

Click the position button to change the position of the watermark without changing 
the angle. Position the cursor anywhere in the preview area. Click and hold as you 
move the mouse, adjusting the watermark image as you want it to appear on the 
printed page.

The following options provide additional means for positioning watermark text:

Centered [default]:  Places the center of the watermark text in the center of the 
page.

User defined:  Select, and then use the x and y boxes to move the text from the 
center of the page: 

• A positive x value moves the watermark text to the right. 
• A negative x value moves the watermark text to the left. 
• A positive y value moves the watermark text down. 
• A negative y value moves the watermark text up.

Angle

Click the angle button to change the angle of the watermark. Position the cursor 
anywhere in the preview area. Click and hold as you move the mouse, rotating the 
watermark image as you want it to appear on the printed page 

The method of rotation is determined by selecting or clearing the Rotate around 
center check box at the far right of the dialog box. Select the check box to rotate text 
around its center; clear the check box to rotate text around its left end. You must 
select User defined in both Angle and Position to enable the Rotate around 
center option.

The following options provide additional means for positioning watermark text:

Diagonal [default]:  Places the watermark at the default angle.

User defined:  Select to change the angle from the default value. Type In the 
number for the angle you want, or select with the up and down arrows. An angle is 
measured in degrees, ranging from 0 to 360.
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Edit Watermark 

The Edit Watermark feature lets you select an existing watermark and make 
changes to its appearance and properties. For standard watermarks, the Watermark 
name and Watermark text cannot be changed. 

1 From the Select watermark list, select a watermark to edit. 1

2 Click Edit to open the Edit Watermark dialog box. 2

3 Make any adjustments you want to the watermark. For details on how to change 
watermark properties, refer to Add Watermark on page 7-5. 3

4 When you are finished editing, click OK to save any changes you made to the 
watermark. To exit the dialog box without saving the changes, click Cancel. 4

Delete Watermark 

The Delete feature lets you delete custom watermarks that were added. The 
standard watermarks cannot be deleted.

1 From the Select watermark list, select a watermark to delete. 1

2 Click Delete. 2

3 In the message box, click Yes to confirm the deletion. To refuse the deletion, click 
No. 3

Security Watermark

Security Watermark is an optional feature that is available with some printing 
systems. Security Watermark adds watermark text and a background pattern to a 
print job. The text blends into the background pattern making it nearly invisible when 
printed. If the printed document is photocopied, the security watermark is visible. A 
security watermark can be used to help protect against unauthorized reproduction of 
documents, or simply to differentiate original documents from photocopies. 

Note:  Security Watermark is unavailable for Windows Vista. 

If Security Watermark is available for your printing system, the installation program 
offers the opportunity to install it during installation of the printer driver. If you have 
already installed the printer driver, you can install Security Watermark using the 
installation CD-ROM that came with your printing system. 

The Security Watermark feature is accessed from the Advanced tab. To enable the 
button that opens the Security Watermark dialog box, PCL XL must be selected as 
the PDL (Page Description Language). To view or change PDL settings, in the 
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Windows Printers and Faxes folder right-click the icon for your printing system, and 
select Properties. Click the Device Settings tab, then click PDL.  

To enable the Security Watermark feature, select a watermark from the list. You can 
choose one of the standard security watermarks, or create your own text. To disable 
the security watermark feature, at the top of the list select [None]. If [None] is 
selected, no security watermark is applied to the document, and all options in the 
dialog box are unavailable, except Add.

The preview area provides an idea of how the security watermark and background 
appears on a photocopied page. It is useful for viewing any adjustments made to the 
appearance of the text. Only a section of the preview page is displayed; it does not 
show how the entire page appears. The preview shows all security watermark 
settings except Pattern shading, Text contrast, Overprint, and Print as footer 
also.

Security watermark is available only when these driver features are set as follows: 

• Scaling set to 100%
• Print size set to 100%
• Gutter – Reduce Image to Fit set to Off
• Multiple pages per sheet set to Off
• Booklet set to Off
• Watermark set to Off
• Poster set to Off
• Kyocera Image Refinement set to Off
• Resolution set to 600 dpi 
• EcoPrint set to Off
• Monochrome Brightness and Contrast set to 0 

The Select security watermark list is constrained to [None] if any of these settings 
are changed. The reverse also applies: if Security Watermark is set to anything other 
than [None], the settings are constrained by the driver to the following values:

• Scaling set to 100%
• Print size set to the same size as Page size
• Gutter – Reduce Image to Fit set to Off
• Multiple pages per sheet set to Off (pages per sheet is set to 1)
• Booklet set to Off
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• Watermark set to Off
• Poster set to Off
• Print Quality - Custom is constrained as follows:

• Kyocera Image Refinement set to Off
• Resolution set to 600 dpi 
• EcoPrint set to Off

• Monochrome Brightness and Contrast set to 0. 

Select Security Watermark 

Select a watermark from the Select security watermark drop-down list. The 
selection list contains these standard security watermarks: Confidential 1, 
Confidential 2, Sample, and Copy. For details on creating your own watermarks, 
see Add Security Watermark on page 7-10.

Note:  The quality and effectiveness of the printed and photocopied security 
watermark is dependent on the particular printing system and the settings used. 
Before printing a security watermark, it is necessary to adjust the calibration and print 
calibration pages. It is also necessary to adjust the calibration, then print calibration 
pages, whenever certain changes are made to the printing system or security 
watermark settings. See Adjust Calibration on page 7-12 for more information on 
how to perform these important steps. 

Page Selection

Page selection options are enabled after a security watermark is selected from the 
list. Choose one of the following: 

All pages

The security watermark prints on every page of the document.

First page only

The security watermark prints only on the first page of the document.

All pages except first page

The security watermark prints on all pages of the document except the first page.

Only on specified pages

To print the security watermark on specific pages, type individual page numbers 
separated by commas in the text box, or a page range separated by a hyphen.

For example, if you type 2 in the text box, the security watermark prints only on page 
2. If you type 1, 3, 5-12 the security watermark prints on page 1, page 3, and pages 
5 through 12. 

If the Only on specified pages option is selected and you click OK without entering 
any numbers, you are prompted to specify page numbers. 

Print onto front outside cover

Select this option to print the security watermark on the front cover page. Print onto 
front outside cover is enabled when Cover mode is selected in the Publishing tab. 
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When printing is specified for the first page under Page Selection and Front outside 
is selected In the Publishing tab, Print onto front outside cover is automatically 
selected by the driver. (Even though the check box shows as selected, the option is 
disabled.)

If you want, in the Publishing tab you can also select different media for the covers 
than that used for the rest of the print job. For more details on Cover mode, see the 
Publishing chapter.

Add Security Watermark

You can create your own custom security watermarks with different fonts, styles, 
colors, sizes and angles. You can also make changes to the footer, footer position, 
background pattern, pattern shading, and text contrast. A maximum of 26 security 
watermarks can be added (in addition to the existing standard security watermarks). 

Note:  The Add button is unavailable when the number of security watermarks 
reaches the maximum of 30. You must delete items to make the Add button 
available again. 

1 Click Add to open the Add Security Watermark dialog box. 1

2 Type a descriptive name for your watermark in the Security watermark name text 
box. The name can be different from the actual watermark text, but the name cannot 
be the same as one of the standard security watermark names. After the new 
watermark is added, its name appears in the Select security watermark drop-down 
list. 2

If you type the same name as a previously added security watermark, when you try 
to add the new watermark the driver prompts you for a decision to replace the one 
that already exists. Click Yes to replace the existing security watermark with the new 
one, or click No to cancel the Add action.

If you do not type a name, and the name text box is left blank, the driver prompts you 
to type a name. A security watermark cannot be saved with a blank name.

3 Up to three lines of text can be printed as a security watermark. Though the text lines 
(Line 1, Line 2, Line 3) are all optional, at least one of the lines must contain text.3

To leave a text line blank, select [None] from that line’s drop-down list.

With User Defined selected from the Line text drop-down list, type the text you want 
in the text box next to the drop-down list. The maximum length of each line of text is 
39 characters. As you type, your text appears in the preview pane at the left. 

As an alternative to creating your own security watermark text, you can choose one 
of the following selections from the list. These options direct the printing system to 
retrieve information from the computer or printer driver to print the security 
watermark:

For date, time, and job selections, only a label for the selection appears in the 
preview panel. When the job is printed, the actual date, time or job information prints 
as the security watermark text.

• Computer name • Mac address • Time
• Date and time • User name • IP address
• Job name • Date • Job ID
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4 To add the new custom security watermark, click OK. To quit the dialog box without 
saving the watermark, click Cancel. 4

Additional Options

Fonts 

Select a font for the new watermark from the Font list. The Security Watermark 
feature uses only TrueType fonts. Select a font Size and Style. To adjust the Angle 
of the text on the page, select from the list. An angle is measured in degrees, ranging 
from 0 to 180. The default is 45 degrees.

Print as Footer Also

Select this option to print the first available line of text (in the Line 1, Line 2, or Line 
3 text boxes) as a footer on the document page. Select Left, Center, or Right to 
position the text in the footer.

Since the actual security watermark text may not be visible on the document original, 
the footer can be useful for reproducing the text visibly in an inconspicuous place at 
the bottom of the page, 

Outline Text

This option produces an effect on the photocopied page that is the reverse of the 
standard result. If the check box for Outline text is cleared (the standard printing 
option), the text is the darkest, most visible part of the photocopy. If selected, the 
background is the most visible part, creating an outline around the text which makes 
the text appear white. The default setting for Outline text is On.

Watermark Color

On monochrome printers, Watermark Color is set to Black for printing security 
watermark text and background. 

Background Pattern

Select a Background Pattern from the drop-down list for printing the security 
watermark background. 

Available background pattern choices are: 

Overprint

Select Overprint to print the security watermark over the document content, leaving 
the content visible. The effect is the security watermark seems blended in with the 
document content. This is useful for applications such as Microsoft Power Point and 
Internet Explorer, where the document content fills the entire page. If the Overprint 
check box is cleared, the security watermark is covered with the document content.

In the Device Settings, PDL Settings dialog box, if GDI compatible mode is 
selected, then Overprint is selected automatically.

• Wave • Tile
• Leaf • Plaid
• Diamond • Square
• Lattice • Crystal
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Adjust Calibration 

Use this option to set and make adjustments to the Pattern shading and Text 
contrast for each individual security watermark. You can print sample calibrations to 
help you determine the appearance of the security watermark. 

The quality and effectiveness of the printed and photocopied security watermark is 
dependent on the particular printing system and the settings used. Before printing a 
security watermark it is necessary to adjust the calibration, and then print calibration 
pages.

Calibration should be adjusted (and calibration pages printed) under these 
circumstances:

• Before using the Security Watermark feature the first time for each standard or 
custom security watermark.

• When the toner is replaced.
• After periods of heavy printing activity.
• When the physical printing device is replaced.
• After changing the background pattern.

1 Click Adjust Calibration to open the Calibration Adjustments dialog box. 1

2 Pattern shading: Select Light, Normal, or Dark from the list for the shading density 
to apply to the pattern background. The default is Normal. 2

3 Text contrast: Select a contrast level from the list to specify text darkness in relation 
to the background pattern. Contrast 1 is the lightest against the background, and 
Contrast 9 is the darkest. The default value for Text contrast varies with the printing 
system model. 3

4 Print sample: Click to print a sample page of the selected text contrast and 
background shading density. For comparison, the page also includes other text 
contrast options. Your settings are identified in the Current selection box bordered 
in black. 4

5 For best results, print three separate sample pages using each of the Pattern 
shading selections, Light, Normal and Dark. This provides the best range of 
choices for Pattern shading and Text contrast settings. 5

6 To ensure the security watermark prints and photocopies correctly, select the 
combination of Pattern shading and Text contrast settings where the text is the 
most nearly invisible. 6

7 To save your calibration adjustments, click OK. To quit the dialog box without saving 
new adjustments, click Cancel. 7



Advanced

7-13 KX Driver

Edit Security Watermark 

The Edit Security Watermark feature lets you select an existing watermark and 
make changes to its appearance and properties. For standard security watermarks, 
the Security watermark name and Line 1, 2, and 3 text cannot be changed. 

1 From the Select security watermark drop-down list, select a watermark to edit. 1

2 Click Edit to open the Edit Security Watermark dialog box. 2

3 Make any adjustments you want to the security watermark. For details on how to 
change security watermark properties, see Add Security Watermark on page 7-10.3

4 When you are finished editing, click OK to save any changes you made to the 
security watermark. To quit the dialog box without saving the changes, click Cancel. 4

Delete Security Watermark 

The Delete option lets you remove a custom security watermark that was previously 
added. The standard security watermarks cannot be deleted. If the watermark 
selected in the list is one of the standard security watermarks, the Delete button is 
disabled.

1 From the Select security watermark list, select a watermark to delete. 1

2 Click Delete. 2

3 In the message box, click Yes to confirm the deletion. To refuse the deletion, click 
No. 3

Enable Client Profile

In a client/server environment, you can use profiles saved in the server or use client 
profiles created and saved in your driver. This feature is available in the Advanced 
tab only in a client/server environment. 

• Clear the Enable client profile check box to select profiles from the server to 
apply to your print jobs. Server profiles are read-only.

• Select the Enable client profile check box to create and save custom profiles in 
your (client) driver. 

EMF Spooling

When printing large documents, it can be beneficial to select EMF spooling. This 
delays spooling and returns the user to their application more quickly. EMF spooling 
is not available when KPDL is selected as the page description language (see Page 
Description Language (PDL) on page 2-8).
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8 Profile

This feature lets you save printer driver settings as a profile. You can select multiple 
options in the Printing Preferences tabs, save them to a profile, and use all of them 
at once when you apply the profile. For example, you can save a profile with selected 
options for Print on both sides, landscape, and rear tray destination. Exported 
profiles can be shared with other KX Drivers on your computer or other computers. 
A maximum 26 profiles can be saved in one driver, including the default profile.

A set of common profiles can be installed as optional components from the Printer 
Installation Wizard. 

Note:  The Device Settings tab options cannot be saved to a profile.

Add Profile

Follow these steps to create a new profile.

1 Select the options you want in each Printing Preferences tab. 1

2 At the bottom of any tab, click Profile. 2

3 Click Add to open the Add Profile dialog box. 3
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4 Type a Name for the profile, select an Icon, and type an optional Description. The 
name can be up to 31 characters, the description can be up to 255 characters. 4

5 Click OK to save the profile. 5

6 Click Apply to activate the selected profile to the current print job. 6

Note:  To reset the printer driver to default settings, select the Factory Default 
profile and click Apply. This clears the settings of a selected profile. 

Edit Profile 

Follow these steps to edit a profile.

1 In the Printing Preferences dialog box, at the bottom of any tab, click Profile. 1

2 Select a profile and click Edit. 2

3 The Edit Profile dialog box appears. You can edit the Name, Icon, or Description.3

4 Click OK to save the profile. 4
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Delete Profile

1 In the Printing Preferences dialog box, at the bottom of any tab, click Profile. 1

2 In the Profile dialog box, click Import. The Import Profile dialog box appears. 2

3 Select profiles and click Delete. 3

4 Click Yes to delete the profiles. 4

Import and Export Profile

You can export and save a profile on your computer and transfer it to other 
computers, then use it with other printing systems. Only one profile can be exported 
at a time. Use the import feature to import a profile.

Export

1 In the Printing Preferences dialog box, at the bottom of any tab, click Profile. 1

2 Select a profile and click Export. 2

3 The Export Profile dialog box appears. Name and save the profile. 3

Import

1 In the Printing Preferences dialog box, at the bottom of any tab, click Profile. 1

2 Select a profile and click Open. 2

3 The profile appears in the Select profile list. 3
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Glossary

A Auto Configure   Device settings feature that queries a printing system through the
network and automatically retrieves settings for optional devices, memory, and RAM disk.
Driver settings will be updated with information received from the physical printing system.
Installed devices will be displayed in the Preview image.

C Cassette   Input paper tray.

D dpi   Dots per inch. 

E EcoPrint   Printing mode that reduces the amount of toner placed on the printed page. It
extends the life of the toner cartridge. Because toner saturation is reduced, the entire image,
text and graphics, will appear lighter in the printed job. EcoPrint does not increase print
speed.

F Fast printing   Printing mode that decreases spool size and increases print speed. 

G GDI compatible mode   A page description language option that accurately reproduces
what is viewed on the screen using the Microsoft Graphical Device Interface (GDI)
component to render the document. It generates data in a raster printing format, creating a
larger printable file.

Gutter   Blank space on the left side or top of a printed page that can be increased by scaling
down text and graphics. This supports stapling and hole punching. 

H Halftone screen   Imaging process that breaks down an image into dots. An experienced
user can adjust Halftone screen settings to create shades of gray in graphic images. Larger
dots spaced close together create darker shades, and smaller dots spaced farther apart
create lighter shades. Shading can be varied by adjusting the number of rows of dots, the
angle at which rows of dots are placed, and the shape of the dots.

K Kyocera image refinement   Imaging feature that smoothes the edges of text and vector
graphics. 

M Manual duplex   Method for printing on both sides of a sheet when the printing system
does not support a duplex unit. After the first half of the print job has been printed, the job can
be flipped over and fed from the cassette for the second side printing. 

Monochrome   Imaging mode that uses black toner only.

MP tray   Source tray used for labels, transparencies, envelopes, and custom printing
media. 
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P PDF   The Adobe portable document format (PDF) is independent of the application
software, hardware, and operating system used to create documents, and also of the output
device on which they are displayed or printed. 

PDL   Page Description Language. This is the language used by your computer to tell the
printing system how to print a document. Availability of some printing options depends on the
selected PDL.

Poster   Layout feature for printing a document in a larger size than the maximum supported
by the printer so the cumulative sheets can be assembled as a poster. Use this feature to
print a document in a large, eye-catching poster format, up to 25 times larger than the original
document size. 

PRESCRIBE   Kyocera's Scripting language that you can use to embed commands into
specified locations in a print job. See also Prologue/Epilogue. 

Profile   A set of user defined driver settings that you save as a group. After saved, you can
select a profile by name and apply its settings to a print job without selecting each feature
individually. 

Prologue/Epilogue   Advanced feature that allows you to insert a macro into specific
locations in the print job. An advanced user may choose to use this feature to embed a
PRESCRIBE command that will call a macro to overlay PRESCRIBE form data or a graphic
object, such as a logo or a signature, at a specific point in the print job. 

R Resolution   The number of dots printed in one inch. Higher resolution improves the quality
of detailed printed images. 

T Transparency   Clear sheet used as printing media. 

Transparency interleaving   A Publishing feature that inserts a backing sheet between
printed transparencies. The backing sheet, also known as an interleaf, helps keep
transparencies clean and prevents the transparencies from clinging together. 

W Watermark   Advanced feature that lets you add semitransparent text to a document. 
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Addresses
KYOCERA MITA EUROPE B.V.

KYOCERA MITA AMERICA, INC.

Hacksteen 40, 2132 MS Hoofddorp
The Netherlands
Telephone: +31.20.654.000
Home page: http://www.kyoceramita-europe.com
Email: Info @ kyoceramita-europe.com

Kyocera Mita (Schweiz)
Hohlstrasse 614, 8048 Zurich
Switzerland
Telephone: +41.1.908.4949

Kyocera Mita Nederland B.V.
Beechavenue 25, 1119RA Schiphol-Rijk
The Netherlands
Telephone: +31.20.58.77.200

Kyocera Mita Deutschland GMBH
Otto-Hahn-Str. 12, D-40670 Meerbusch,
Germany
Telephone: +49.2159.918.0

Kyocera Mita (UK) LTD
8 Beacontree Plaza
Gillette Way Reading Berks RG2 0BS
U.K.
Telephone: +44.1189.311.500

Kyocera Mita GMBH Austria
Eduard-Kittenberger-Gasse 95,
1230 Wein
Austria
Telephone: +43.1.86338.210

Kyocera Mita Italia S.p.A.
Via G. Verdi, 89/91, 20063 Cernusco s/N
Milano, Italy
Telephone: +39.02.92179.1

Kyocera Mita Svenska AB
Esbogatan 16B 164 75 Kista
Sweden
Telephone: +46.8.546.55000

Kyocera Mita Belgium N.V.
Sint-Martinusweg 199-201, 1930 Zaventem
Belgium
Telephone: +32.2.720.9270

Kyocera Mita Norge
Postboks 150 Oppsal, NO 0619 Oslo
Olaf Helsetsvel 6, NO 0694 Oslo,
Norway
Telephone: +47.22.62.73.00

Kyocera Mita France S.A.
Parc Les Algorithmes Saint Aubin
91194 GIF-SUR-YVETTE
France
Telephone: +33.1.6985.2600

Kyocera Mita Danmark A/S
Ejby Industrivej 1, DK-200 Glostrup
Denmark
Telephone: +45.5687.1100

Kyocera Mita Espana S.A.
Edificio Kyocera, Avda de Manacor No. 2
28290 Las Matas (Madrid)
Spain
Telephone: +34.91.631.8392

Kyocera Mita Portugal, IDA.
Rua do Centro Cultural, 41 (Alvalade) 1700-106 
Lisbon,
Portugal
Telephone: +351.21.842.9100

Kyocera Mita Finland OY
Kirvesmiehenkatu 4, 00880 Helsinki
Finland
Telephone: +358.9.4780.5200

Kyocera Mita South Africa (PTY) LTD.
527 Kyalami Bouelvard
Kyalami Business Park Midrand
South Africa
Telephone: +27.(0) 11.540.2600

Headquarters:
225 Sand Road
Fairfield, New Jersey 07004-0008
Telephone: (973) 808.8444
Fax: (973) 882.6000

Kyocera Mita Singapore PTE, LTD.
121 Genting Lane, 3rd Level
Singapore 349572
Telephone: 67418733



KYOCERA MITA Corporation

KYOCERA MITA AMERICA, INC.

Kyocera Mita Australia Pty, LTD.
Level 3, 6-10 Talavera Road, North Ryde,
N.S.W. 2113 Australia
Telephone: (02) 9888.9999

Kyocera Mita Hong Kong, LTD.
11/F Mita Centre
552-566, Castle Peak Road
Tsuen Wan, New Territories,
Hong Kong
Telephone: 24297422

Kyocera Mita New Zealand, LTD.
1-3 Parkhead Place, Albany
P.O. 302 125 NHPC
Auckland, New Zealand
Telephone: (09) 415.4517

Kyocera Mita Taiwan Corporation
7F-1-2, No. 41, Lane 221, Gangchi Road
Neihu District, Taipei, Taiwan, 114, R.O.C.
Telephone: (02) 87511560

Kyocera Mita (Thailand) Corp., LTD.
9/209 Ratchada Prachachem Road
Bang Sue, Bangkok 10800, Thailand
Telephone: (02) 586.0320

2-28 1-chome, Tamatsukuri, Chuo-ku
Osaka 540-8585, Japan
Telephone: (06) 6764.3555
Email: http://www.kyoceramita.com

Headquarters:
225 Sand Road
Fairfield, New Jersey 07004-0008
Telephone: (973) 808.8444
Fax: (973) 882.6000

Southeastern region:
1500 Oakbrook Drive
Norcross, Georgia 30093
Telephone: (770) 729.9786
Fax: (770) 729.9873

New York Branch:
1410 Broadway 23rd Floor
New York, NY 10018
Telephone: (917) 286.5400
Fax: (917) 286.5402

Southwestern region:
2825 West Story Road
Irving, Texas 75038-5299
Telephone: (972) 550.8987
Fax: (972) 252.9786

Northeastern region:
225 Sand Road
Fairfield, New Jersey 07004-0008
Telephone: (973) 808.8444
Fax: (973) 882.4401

National Operation Center & 
National Training Center:
2825 West Story Road
Irving, Texas 75038-5299
Telephone: (972) 659.0055
Fax: (972) 570.5816

Midwestern region:
201 Hansen Court, Suite 119
Wood Dale, Illinois 60191
Telephone: (630) 238.9982
Fax: (630) 238. 9487

Latin America region:
8240 N.W. 52nd 
Terrace Dawson Building - Suite 108
Miami, Florida 33166
Telephone: (305) 421.6640
Fax: (305) 421.6666
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KYOCERA MITA CANADA, LTD.

KYOCERA MITA AMERICA MEXICO, S.A. DE C.V.

Western region:
14101 Alton Parkway
Irvine, CA 92618-7006
Telephone: (949) 457.9000
Fax: (949) 457.9119

6120 Kestrel Road, Mississauga,
Ontario L5T 1S8, Canada
Telephone: (905) 670.4425
Fax: (905) 670.8116

Av. 16 de Septiembre #407
Col. Santa Ines
Azcapotzalco Mexico,
D.F. 02130, Mexico
Telephone: (55) 5383.2741
Fax: (55) 5383.7804
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